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Abstract: 

This paper discusses the use of software programs like ETabs 

and Sketchup for modelling, analysing, and designing multi-

story structures. Sketchup is a user-friendly 3D modelling 

software with an extensive database of user-created models for 

various projects, including furniture building and architecture. 

It is used for interior design, landscaping, video game design, 

3D printing, and interior design. Sketchup 3D Warehouse is 

the world's largest 3D model library, hosting over 4.8 

million searchable and pre-made models and products. 

ETABS is a leading software for analysing and designing 

reinforced cement concrete buildings, and many design 

companies use it for their projects. The paper focuses on 

analysis of the G+1 building using ETABS, following IS 

456-2000 guidelines. Dead and live loads are considered for 

structure analysis. 

Keywords: AutoCAD, Sketchup and ETabs 

1. INTRODUCTION

In the realm of architectural design and structural 

engineering, the integration of advanced software tools has 

become imperative for creating efficient, aesthetically 

pleasing, and structurally sound buildings. This project delves 

into the synergistic utilization of SketchUp, Escape, and 

ETABS for the holistic modeling, design, and analysis of a 

residential structure. By harnessing the combined power of 

SketchUp, Escape, and ETABS, this project endeavors to 

demonstrate a holistic approach to a villa modeling, design, 

and analysis. From the inception of design concepts to the 

validation of structural integrity, each stage of the process 

benefits from the synergistic interplay of these software tools. 

Ultimately, the integration of SketchUp, Escape, and ETABS 

not only enhances the efficiency and accuracy of the design 

process but also fosters a deeper understanding of the intricate 

relationship between form, function, and structural 

performance in architectural design. 

2. LITERATURE REVIEW

Following are the research works conducted on analysis 

and design of a building by using different software’s. 

Tal (2013) Master the art of rendering in SketchUp, seamlessly 

transitioning from initial modeling to stunning presentations. 

Tailored for architects, landscape architects, and interior 

designers, this guide unlocks the full potential of SketchUp's 

rendering capabilities. Elevate your designs with lifelike visuals, 

bringing your architectural visions to life with precision and 

style. 

Varalakshmi et al (2014) Discover the design process of a G+5 

residential building using ETABS. Gain insights from the 

International Conference on Advances in Engineering and 

Technology. Explore innovative approaches to structural 

engineering in high-rise construction. 

Abhay Guleria (2014) Dive into the structural analysis of multi-

Storey buildings with ETABS. Explore varied plan 

configurations in the International Journal of Engineering 

Research & Technology. Gain insights into efficient structural 

design and optimization strategies. 

Schreyer (2015) SketchUp empowers architects with robust 3D 

modeling capabilities, extensive extensions for enhanced 

functionality, and seamless integration with BIM workflows. and 

customizable scripting, it facilitates the entire architectural 

design process, from conceptualization to execution. 

Kucinskiene and Kucinskas (2015) Explore landscape design 

visualization possibilities in the Experience Areas feature. Delve 

into the Journal of Sustainable Architecture and Civil 

Engineering for insights. Discover innovative approaches to 

sustainable landscape architecture. 

Chandrashekar and Rajasekhar (2015) Explore the analysis and 

design process of multi-storied buildings with ETABS software. 

Gain valuable insights from the International Journal of 

Scientific and Research. Delve into innovative approaches to 

structural engineering and optimization. 

Gupta (2015) This study investigates the impact of shear wall 

locations on the seismic performance of RCC framed buildings. 

Through comprehensive analysis, it evaluates structural stability 

and resilience under seismic forces. Gain insights into optimizing 

shear wall placement for enhanced building safety in seismic-

prone regions. 

Balaji and Selvarasan (2016) Explore the design and analysis of 

multi-storeyed buildings in ETABS under static and dynamic 

loading conditions. Gain insights from the International Journal 

of Technical Research and Applications. Delve into advanced 

structural engineering techniques for optimized building 

performance. 

Geethu et al. (2016) Dive into a comparative study of multi-

storied building design and analysis using STAAD.Pro and  
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ETABS software. Gain insights into the strengths and 

limitations of each platform. Explore advanced structural 

engineering techniques for optimal building performance. 

Mohith (2017) Gain expertise in commercial building analysis 

and design utilizing ETabs software. Master structural 

engineering principles for robust and efficient designs. 

Generate detailed output and optimize building performance 

with ETabs proficiency. 

Huang et al. (2018) The use of virtual reality (VR) in 

architecture and construction, discussing its benefits, 

applications, and challenges. It highlights case studies, 

discusses challenges like cost barriers, and speculates on future 

directions and opportunities. The survey also explores potential 

advancements and research areas for further development and 

improvement in VR applications. 

Holley (2018) "Beyond Flat Space: Representing Architecture 

in Virtual Reality," focusing on works that explore virtual 

reality (VR) in architecture and spatial representation. Here are 

some key references. 

Brock (2018) This guide provides a comprehensive overview 

of utilizing SketchUp for creating 3D building models tailored 

for builders. It offers step-by-step instructions, tips, and 

techniques to efficiently leverage SketchUp's tools and features 

in architectural design. From conceptualization to detailed 

modeling, this resource equips builders with the skills to 

produce accurate and visually appealing 3D representations of 

their projects. 

Ali et al. (2020) This highlights the computer-aided design, 

analysis, and drafting process for a multi-Storey RCC building 

using ETABS software. It emphasizes the integration of 

advanced modeling techniques, structural analysis, and drafting 

functionalities to ensure robustness and efficiency in the design 

process. Through this approach, engineers can streamline the 

design workflow and enhance the accuracy and reliability of 

structural designs for multi-Storey RCC buildings. 

Dhomne (2021) This study focuses on the analysis and design 

of a multistorey residential building utilizing the ETABS 

software. It explores structural integrity, load distribution, and 

design optimization to ensure safety and efficiency in high-rise 

construction. Through comprehensive analysis and simulation, 

this research aims to provide valuable insights for engineers 

and architects in the construction industry. 

Thakur et al. (2021) This study conducts a design and 

comparative analysis of a G+6 residential building using 

STAAD.Pro and ETABS. It explores the structural integrity 

and performance of the building under various loading 

conditions. Gain insights into the strengths and weaknesses of 

both software platforms for structural engineering. 

Setyaningfebry et al. (2022) These references should provide 

insights into the development of web-based rendering systems, 

with a focus on user experience, scalability, performance 

optimization, and emerging technologies such as virtual reality 

and augmented reality. 

Bruckner et al. (2022) It may explore the integration of various 

disciplines such as architecture, engineering, and landscape 

architecture within BIM workflows, highlighting challenges, 

benefits, and best practices identified in relevant literature. The 

study may offer insights into optimizing collaboration and 

efficiency in contemporary building projects through BIM-

oriented approaches. 

Cline (2023) SketchUp offers seamless 3D visualization and 

space planning, ideal for interior design projects. From concept 

to execution, it enables designers to efficiently create, modify, 

and present their designs with precision and creativity. 

Ardhan et al. (2023) SketchUp 3D modeling techniques, and 

perhaps case studies or best practices in designing dual-

function buildings. It may delve into topics such as space 

optimization, functionality, aesthetic considerations, and 

practical applications within the context of PT. Daffa 

Ekspressindo Logistics’ specific requirements and constraints. 

3.0 PLANNING AND MODELLING 

For the drafting and design of any construction, AutoCAD is 

quite beneficial. The fields of architecture and construction also 

employ this software. The software's several built-in 

capabilities enable complex drafting. In addition to 2D, 3D and 

other dimensions, AutoCAD is also appropriate for perspective 

design, which refers to a way of perceiving objects.  

International Journal of Engineering Research & Technology (IJERT)

ISSN: 2278-0181http://www.ijert.org

(This work is licensed under a Creative Commons Attribution 4.0 International License.)

Published by :

IJERTV13IS040154

Vol. 13 Issue 4, April 2024

www.ijert.org
www.ijert.org


Fig 1: Auto CAD Plan 

BED ROOMS = 14’X12’      MASTER BEDROOM=16’X14’ 

LIVING AREA = 14’6”X22’      HOME THEATER=16’X20’ 

POOJA ROOM = 9’X5’      STORE ROOM=14’X12’ 

KITCHEN = 9’6”X6’      BALCONY=18’X20’ 

TOILETS = 6’9”X4’ 

PARKING AREA= 15’X16’3” 

3.1 Importing a CAD file into SketchUp 

After you've checked and prepared your CAD file, you're 

ready to import it into SketchUp. The following steps walk 

you through the import process for your operating system: 

1. In SketchUp, open the SketchUp model into which

you want to import your .dwg or .dxf file.

2. Select File > Import. An Import dialog box appears.

3. Navigate the place your hard drive where your CAD

file is saved.

4. From the Files of Type drop-down list, 

select AutoCAD Files (*.dwg, *.dxf). 

5. Select the file you want to import.

6. Click the Options button. The Import AutoCAD

DWG/DXF Options dialog box appears, as shown in

the following figure.

7. (Optional) In the Geometry area, select your

preferences for the following options:

o select Merge Coplanar Faces to tell SketchUp to

automatically remove triangulated lines from

planes.

o Selecting the Orient Faces Consistently box tells

SketchUp to analyse the direction of imported

faces and orient the faces so that their direction is

uniform.

8. (Optional) Select the Preserve Drawing Origin

checkbox to place the imported geometry at the

origin defined in the .dwg or .dxf file. Leave the

checkbox deselected if you want to place the

imported geometry near the SketchUp origin.

9. (Optional) To import geometry at the correct scale,

select the unit used in your CAD file from
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the Units drop-down list. Your options are Model 

Units, Inches, Feet, Yards, Miles, Millimetres, 

Centimetres, Meters and Kilometres. 

10. Click OK in the Import AutoCAD DWG/DXF

Options dialog box.

11. Back in the Import dialog box, click

the Import button, SketchUp Pro begins importing

your CAD file.

Fig 2: Importing a CAD file into SketchUp 

3.2 Exporting a SketchUp Model as a 3D CAD file 

When you export a SketchUp model as a 3D CAD file, you 

can select what entities are exported. To export your model, 

follow these steps: 

In SketchUp, select File > Export > 3D Model. The Export 

Model dialog box appears. 

1. Navigate to the location where you want to save your

exported file.

2. (Optional) Change the file name if you like. By default,

the exported file uses the same name as your SketchUp

file name.

3. Select either .dwg or .dxf as the file format for your

exported file. In Microsoft Windows, select your file

type from the Save As Type drop-down list. In Mac OS

X, use the Format drop-down list.

4. Click the Options button to open the Export Options

dialog box, shown in the following figure. From

the AutoCAD Version drop-down list, select the version

of AutoCAD you'd like to use to open the exported file.

In the Export area, select the checkbox for each type of

entity that you want to include in the exported file.

Click OK when you're done. Back in the Export Model

dialog box, click Export, and your file appears in the

location where you chose to save it.
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Fig 3: Exporting a SketchUp Model as a 3D CAD file 

   Fig 4: Bed room Fig 5: Hall 
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Fig 6: Elevation without rendering         Fig 7: Elevation with rendering 

4. ANALYSIS AND DESIGN

4.1 IMPORTING AUTOCAD PLAN TO ETABS 

ETABS is an engineering software product designed for 

multi-story building analysis and design. It offers modelling 

tools, load prescriptions, and analysis methods that 

coordinate with the unique grid-like geometry of these 

structures. ETABS can evaluate basic or advanced systems 

under static or dynamic conditions, and can capture material 

nonlinearity under monotonic or hysteretic behaviour. Its 

intuitive features make it practical for applications of any 

complexity. ETABS integrates every aspect of the 

engineering design process, from design conception to 

schematic drawing production. It includes  

features for steel and concrete frames, composite beams, 

columns, steel joists, and concrete and masonry shear walls. 

The software also supports nonlinear modelling techniques 

and provides comprehensive and customizable reports for 

analysis and design output. ETABS is an invaluable suite of 

tools for structural engineers designing buildings, from one-

story industrial structures to tall commercial high-rises. 

Import the AutoCAD Plan: 

• In ETABS, navigate to the "File" menu.

• Select "Import" and then choose "AutoCAD Drawing

(*.DWG)" from the dropdown menu.

• Browse to the location where you saved your

AutoCAD drawing file and select it.

• Click "Open" to import the AutoCAD plan into your

ETABS model
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Fig 8:  Centre line diagram 

4.2 PLAN OF THE VILLA 

Fig 9: Ground Floor Fig 10: First Floor 

4.3 Loads Considered: 

4.3.1 Dead Load:  

All permanent constructions of the structure form the dead 

loads. The dead load comprises of the weights of walls, 

partitions floor finishes, false ceilings, false floors and the 

other permanent constructions in the weights. the unit weights 

of plain concrete and reinforced concrete made with sand and 

gravel or crushed natural stone aggregate may be taken as 24 

kN/m” and 25 kN/m” respectively. 
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 Fig 11: Dead load for ground floor Fig 12: Dead load for first floor 

4.3.2 Imposed Load or live load: 

Imposed load is produced by the intended use or occupancy 

of a building including the weight of movable partitions, 

distributed and concentrated loads, load due to impact and 

vibration and dust loads. Imposed loads do not include loads 

due to wind, seismic activity, snow, and loads imposed due 

to temperature changes to which the structure will be 

subjected to, creep and shrinkage of the structure, the 

differential settlements to which the structure may undergo. 

  Fig 13: Live load for ground floor 

 Fig 14: Live load for first floor 

4.3.3 Wind Load: 

Air mass moving at a certain velocity has a kinetic energy 

equal to ½mv2, where m and v are the mass and velocity of 

air in motion. When an obstacle like a building is 

encountered, a part of the kinetic energy is converted to 

potential energy of pressure. The intensity of wind pressure 

depends on factors like the angle of incidence, roughness of 

the surrounding area, and the structure's lateral resistance. 

The maximum design wind pressure depends on the 

duration of gusts and the probability of exceptional wind 

pressure. Most buildings have wind pressure specified in 

Indian Standards, IS code 875 -3 (1964), but tall and slender 

buildings may develop aerodynamic instability due to 

constant gusts and vibration during wind storms. If the 

building's energy absorbs more than it can dissipate, the 

vibration amplitude increases until failure occurs. Wind 

tunnel experiments are often necessary for detailed study. 

International Journal of Engineering Research & Technology (IJERT)

ISSN: 2278-0181http://www.ijert.org

(This work is licensed under a Creative Commons Attribution 4.0 International License.)

Published by :

IJERTV13IS040154

Vol. 13 Issue 4, April 2024

www.ijert.org
www.ijert.org


Fig 15: Wind load 

4.4 SHEAR FORCE 

Fig 16: Shear Force variation 
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4.5 BENDING MOMENT 

   Fig 17: Bending Moment variation 

4.6 REINFORCEMENT VALUES 

 Fig 18:  Ground Floor 
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4.7 BEAM REINFORCEMENT DETAILS 

Table 1: Beam reinforcement details 

BEAM NO’S DIMENSIONS (m) REINFORCEMENT 

B1 4.54 X 0.3 X 0.3 

6#12@270 

B2 5.27 X 0.3 X 0.3 

B3 0.96 X 0.3 X 0.3 

B4 4.54 X 0.3 X 0.3 

B5 4.31 X 0.3 X 0.3 

B6 3.93 X 0.3 X 0.3 

B7 3.93 X 0.3 X 0.3 

B8 4.91 X 0.3 X 0.3 

B9 5.87 X 0.3 X 0.3 

B10 0.65 X 0.3 X 0.3 

B11 1.88 X 0.3 X 0.3 

B12 1.81 X 0.3 X 0.3 

B13 1.51 X 0.3 X 0.3 

B14 1.28 X 0.3 X 0.3 

B15 0.96 X 0.3 X 0.3 

B16 1.49 X 0.3 X 0.3 

B17 1.49 X 0.3 X 0.3 

B18 1.49 X 0.3 X 0.3 

B19 1.71 X 0.3 X 0.3 

B20 2.71 X 0.3 X 0.3 

Fig 19:  First Floor
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B21 2.71 X 0.3 X 0.3 

         6#12@270 

B22 1.79 X 0.3 X 0.3 

B23 1.79 X 0.3 X 0.3 

B24 1.79 X 0.3 X 0.3 

B25 1.79 X 0.3 X 0.3 

B26 0.99 X 0.3 X 0.3 

B27 3.44 X 0.3 X 0.3 

B28 3.44 X 0.3 X 0.3 

B29 0.65 X 0.3 X 0.3 

B30 0.99 X 0.3 X 0.3 

B31 3.44 X 0.3 X 0.3 

B32 3.44 X 0.3 X 0.3 

B33 0.65 X0.3 X 0.3 

B34 1.88 X 0.3 X 0.3 

B35 1.99 X 0.3 X 0.3 

B36 6.97 X 0.3 X 0.3 

B37 9.08 X 0.3 X 0.3 

B38 3.31 X 0.3 X 0.3 

B39 1.21 X0.3 X 0.3 

B40 1.79 X 0.3 X 0.3 

B41 1.79 X 0.3 X 0.3 

B42 4.53 X 0.3 X 0.3 

B43 3.93 X 0.3 X 0.3 

B44 3.93 X 0.3 X 0.3 

B45 2.78 X 0.3 X 0.3 

B46 2.10 X 0.3 X 0.3 

B47 2.10 X 0.3 X 0.3 

B48 0.65 X 0.3 X 0.3 

B49 3.87 X 0.3 X 0.3 

B50 2.10 X 0.3 X 0.3 

B51 2.16 X 0.3 X 0.3 

B52 2.16 X 0.3 X 0.3 

B53 1.79 X 0.3 X 0.3 

B54 1.79 X 0.3 X 0.3 

B55 0.65 X 0.3 X 0.3 

B56 3.87 X 0.3 X 0.3 

B57 4.32 X 0.3 X 0.3 

B58 0.96 X 0.3 X 0.3 

B59 4.5 X 0.3 X 0.3 

B60 5.27 X 0.3 X 0.3 

B61 0.96 X 0.3 X 0.3 

B62 4.54 X 0.3 X 0.3 

B63 4.31 X 0.3 X 0.3 

B64 5.87 X 0.3 X 0.3 

B65 3.93 X 0.3 X 0.3 

B66 4.54 X 0.3 X 0.3 

B67 4.31 X 0.3 X 0.3 

B68 3.93 X 0.3 X 0.3 
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B69 3.93 X 0.3 X 0.3 

6#12@270 

B70 4.91 X 0.3 X 0.3 

B71 0.65 X 0.3 X 0.3 

B72 1.88 X 0.3 X 0.3 

B73 1.81 X 0.3 X 0.3 

B74 1.50 X 0.3 X 0.3 

B75 0.96 X 0.3 X 0.3 

B76 1.49 X 0.3 X 0.3 

B77 1.49 X 0.3 X 0.3 

B78 1.49 X 0.3 X 0.3 

B79 1.71 X 0.3 X 0.3 

B80 2.71 X 0.3 X 0.3 

B81 2.71 X 0.3 X 0.3 

B82 0.65 X 0.3 X 0.3 

B83 1.88 X 0.3 X 0.3 

B84 1.99 X 0.3 X 0.3 

B85 2.78 X 0.3 X 0.3 

B86 0.96 X 0.3 X 0.3 

B87 3.44 X 0.3 X 0.3 

B88 3.44 X 0.3 X 0.3 

B89 6.97 X 0.3 X 0.3 

B90 9.08 X 0.3 X 0.3 

B91 3.31 X 0.3 X 0.3 

B92 1.21 X 0.3 X 0.3 

B93 1.79 X 0.3 X 0.3 

B94 1.79 X 0.3 X 0.3 

B95 4.53 X 0.3 X 0.3 

B96 3.93 X 0.3 X 0.3 

B97 3.93 X 0.3 X 0.3 

B98 2.78 X 0.3 X 0.3 

B99 0.65 X 0.3 X 0.3 

B100 3.85 X 0.3 X 0.3 

B111 2.10 X 0.3 X 0.3 

B112 2.10 X 0.3 X 0.3 

B113 2.78 X 0.3 X 0.3 

B114 3.87 X 0.3 X 0.3 

B115 2.10 X 0.3 X 0.3 

B116 2.10 X 0.3 X 0.3 

B117 1.79 X 0.3 X 0.3 

B118 3.87 X 0.3 X 0.31.79 3.87 X 0.3 X 0.3X 0.3 X 0.3 

B119 0.65 X 0.3 X 0.3 
3.87 X 0.3 X 0.3
4.32 X 0.3 X 0.3

B121
B121

International Journal of Engineering Research & Technology (IJERT)

ISSN: 2278-0181http://www.ijert.org

(This work is licensed under a Creative Commons Attribution 4.0 International License.)

Published by :

IJERTV13IS040154

Vol. 13 Issue 4, April 2024

www.ijert.org
www.ijert.org


As per the design, it is observed that all columns are having same dimensions and reinforcement. 

Table 2: Column reinforcement details 

DIMENSION (m) REINFORCEMENT 
3 X 0.3 X 0.3 4#16 

5. CONCLUSION

The paper discusses the use of ETABS for structural design, 

highlighting its benefits in strength, serviceability and 

durability. It suggests that altering beam and column 

dimensions and producing reinforcement detailing can 

improve the design process. The study also highlights the 

effectiveness of Google SketchUp in building interior design, 

with its virtual reality capabilities providing valuable insights 

into spatial relationships. Combining SketchUp and Enscape 

with ETABS streamlines project workflows, resulting in 

high-quality, aesthetically pleasing, and structurally sound 

architectural designs. 
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